Getting Started with FECFile
User Manual

Hands-on Help with FECFile and Electronic
Filing for Candidate Committees

The “Getting Started with FECFile User Manual”” was developed as a quick reference tool for Candidate
Committees to be used as a training aid in FEC sponsored Reporting Workshops. Candidate committees
must consult the FECFile User Manual for Candidate Committees for more detailed reporting assistance.

Reports Analysis Division (800) 424- 9530 Ext. 1130
Electronic Filing Office (800) 424- 9530 Ext. 1307
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Getting Started

Beginning Electronic Filing

Electronic filing is:
1. Required when a political committee or other person receives contributions or makes

expenditures in excess of $50,000 in the current calendar year or has reason to expect to do so.

2. Voluntary for any political committee or other person that receives contributions or makes
expenditures less than $50,000 in the current calendar year. However, once a committee decides
to e-file on a voluntary basis, it must continue to do so for the remainder of the calendar year,
unless the Commission determines that extraordinary and unforeseeable circumstances have
made it impractical for the political committee or other person to continue filing electronically.

Creating electronic filing passwords for new committees:
Committees registering with the FEC may create an electronic password when using the online

webform to complete the Form 2 (Statement of Candidacy) and Form 1 (Statement of
Organization). Committees who filed the Form 2 and Form 1 by mail or electronic filing
software can follow the instructions below to create a password.

Creating electronic filing passwords for registered committees:
1. If you have registered your committee and no electronic filing password has been previously

assigned to the committee, you can use the FEC’s Electronic Filing Password Request webpage.
http://www.fec.gov/elecfil/passwords.shtml

2. The request must come from the official committee treasurer or assistant treasurer.
3. Access the password request webpage and click the Get Started box to request a new password.

Registered Committees: How do I get a password?
If you are the committes treasurer, you can create a password using the Electronic Filing Password Request (see links below].

Using the Electronic Filing Password Request a treasurer can:
+ Create a new electronic filing password (only for committees filing electronically for the first time],

+ retrieve a forgotten password, and
+ change a password.

Get Started
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New Electronic Filing Password Request

This option allows committees to receive an electronic filing password if no
electronic filing password has been previously assigned to the committee. A
temporary password will be emailed to you and the committee's official email
address(esz) with instructions on how to create a personalized password.

* Indicates required fields

e Committee ID: I *

e Treasurer's
Last Name:

Confirm Email
Address:
Please verify your authority prior to continuing.
[ I represent that I am the duly appointed tressurer and have the suthority to
sign FEC reports for the above mentioned committee. ™

Requestor
e Name: I

|
© Email Address: |
|

Requestor
e Title: I

A temporary password will be emailed to you with instructions how to activate
and change your password,

Submit Clear Form Help

4. After entering the required information, click Submit.

5. A temporary password will be emailed to you with instructions on how to activate and change
your password.

6. After being issued an electronic filing password, you can also use the Electronic Filing
Passwords webpage to change a password and retrieve a forgotten password:

a. Change a password - https://webforms.fec.gov/psa/change.htm

b. Retrieve a forgotten password — https://webforms.fec.gov/psa/forgot.htm

NOTE: If you received an electronic filing password via fax, it remains valid. If you have forgotten this
faxed password, contact the FEC Electronic Filing Office (800- 424- 9530 Ext. 1307) to gain access to
the new online electronic filing password system.
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Downloading Software:

1.

o A~ W

10.
11.

Note:

From www.FEC.gov, click the e-Filing link at the bottom of the page.

Links Inspector General

20463 (EIEIEI) 424 9530 In Washington (202) &

nnnnnnnnnnnnnnn L tln HE R PR S lﬁkn IIIHL LT R N

Click FECFile Filing Software.
Confirm Minimum System Requirements are met.
Click Download FECFile Now.

Click Download Now at the top of the screen for the most recent version of FECFile.

FECFile Update List

Download Now
Build X. X . X.X.

Enter the committee’s information and choose Submit.

Enter additional information (for new committees only).

Click the FECFile X.X.X.X link to download FECFile.

Follow your computer’s download instructions.

Double-click the FECFile install icon and follow the installation prompts.

FECFile will automatically check for the latest program updates every time you start the

software.

FECFile Training Manual
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Using FECFile
FECEFile Video Tutorial: ""FECFile Introduction""

FECFile Video Tutorial: ""Setting Up a FECFile Database for a Candidate""
Creating a New Committee File

1. Start FECFile using either the desktop icon or the computer’s Start Menu.
2. Click Create a new committee file. Use this file every time a report is created.
3. A window will appear to confirm the creation of a new committee file. Click OK.

Dp=ne & Committes File 3 x|

@ Lreate a new Committee File|

€ Qpen an existing Commites Fle

4. Choose the committee type from the following list and click OK.

Select your Committee Type il

Fa - Joint Fundraizing Committes [Authorized)

F3 - Jont Fundraizing Committee [Unauthorized)

F3< - Political Action Cornmittes

F3 - Political Party Organization

F3x - Other [Palitical] Cormmittes

F4 - Committee/Organization supporting corvention

F5 - Independent Expenditure Filer - Individual [Mon-political/Mon-profit]

F& - Independent Expenditure Filer - Organization [Mon-palitical /M on-profit]
F? - Communication costs Filer

F3 - Electioneering Communications Filer - [Mon-poliical/Mon-profit] Individual
F3 - Electioneening Communications Filer - [Mon-palitical/Mon-prafit] Organization

FECFile Training Manual
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5. Enter the committee’s ID number, name, and address. In the
“Authorizing Candidate” field at the bottom of the page, type

the candidate’s name (last name, first name) and press Tab. e oL |
a. A new window will open. Enter the candidate’s o oo e |
information and click OK. The “Campaign Committee I Indvidual |
— FILER” window will reappear. Leo Home I Hide Hame
b. Enter the candidate’s information at the bottom of the Ertrane i Bt T
window. When finished, click OK. s
I I
City State Zip
I INone jl
Authorizing Candidate
Fecfile
L] E Would you like to create a Report and enter your Report Information now?
L] Candidate Information
Office State District Other [D |
Yes Mo | =[None | |
oK I Cancel |

6. Click Yes at the prompt.

L] E Firsk, please enter the Election Cycle For this report,
L]

Campaign Committee - FILER

Tups ™| Hationall Mu

I Carmpaign Caommittee

Committee |0 [eg. C12345678)

7. Click OK at the prompt.

8. Enter the current election cycle. An election cycle begins the day after the previous general
election for that office and ends on the date of the next general election. For House candidates

Election cycle information

Date From

P

Date Thru

—

Cancel |

Emter 2005 of the owverall expenditure limit a2 publizhed by the FELC

—

x|

this is 2 years, for Presidential this is
4 years, and for Senate candidates
this is 6 years.
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Creating the First Report (Form 3) in a New Committee File

1.

Select the Type of Report from the Report’s drop down
menu and, if necessary, modify the “Date From” and “Date
Thru” fields.

Select the election cycle.

To sign the report, click in the Signed by box. Enter the
treasurer’s name (last name, first name). If the treasurer
has not already been entered into FECFile, press Tab or
Enter.

a. An “Individual/Organization” box will appear.
Ensure that the type selected is “Individual other
than a Candidate” and enter the rest of the
treasurer’s information (name, address, etc.).

b. After entering the treasurer’s information, click OK
to return to the Report Information box.

After all the information is entered, click OK.

5. A window will appear, with options for what to do next in

the report. To view the Summary Page and begin to add

Report inflormation

T a i
D.abe From Diabe Thiu Election date

[7r1/2009 {3ra0v2009 [

Elechion cycla funrws in Shple

%

T |
by
. S-am
Duvis, Som - 785 Whie Clak Sheet |

Smith, Jos - 535 Eln Strest

™ This pepert discloses & new commttes addiess

Diavis. Sam - TG Whate Ouk Street..,
Smith, Joe - 535 Eln Sireet_.

o]

transactions click OK. To view the Individuals/Organizations screen, click Cancel.

Fecfile

": You may proceed to add transactions to the current report OR you may choose to add Individuals/Organizations to your file. Would you like to add
L

transactions to the current report now?

]

Cancel |

x|
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Creating a New Report in an Existing Committee File

1.
2.

In the “View” menu, click Reports.

Select the report bype ﬂ

In the “Edit” menu, click New, or right click anywhere

in the Reports window and click New.

Select the report type you would like to create (Forms

3,6,3L,1, 1M, 99, or 2) and click OK.

Creating a Statement of Organization
(Form 1)

1.

Create a Statement of Organization by
following the steps to create a new report as
outlined in the previous section and choose
Form 1 (Statement of Organization). Click
OK.

The “Statement of Organization” dialog box
appears. Select the type of committee, and
enter the party code, website address (if
applicable), e-mail address (required), and
date.

If the “Treasurer” field does not already
contain the name of the committee’s
treasurer, click Edit.

a. Select the treasurer’s name from the
scroll box. (Note: if the treasurer’s
name does not appear in this box,
press Tab or Enter to input that
individual’s information.)

b. Enter the Treasurer’s phone number
and  Title/Relationship to  the
committee, then click OK.

To enter connected organizations, affiliated
committees, leadership PAC sponsors, joint
fundraising  representatives;  designated
agents; and banks/other depositories, click

Report of Beceipts and Dizbursements [Form F3]
48 hour notice [Form ]

Form 3L - Repart of Bundled Contributions

Form 1 [Statement of Organization)

Form Tk [Motification of Multicandidate Statuz)
Mizcellaneous Electronic Submizzion [Form 39)
Form 2 [Statement of Candidacy]

(] I Cancel
xq
Type of Commites
(D Principal Candidate Comemities Ii
O Aushorized Commities (Mot Principal]
© Suppos/Dppose: ondy one Candidats [unsuthorzed)
O Separste Segregaled Fund
= Gors © Jarization g
C L He igerzetion
D I
OH&EEFqu.w#mwemmnm
O Party Committee
FH € Stat r
O Joint Funcraising Flepresentative [Suthorzed: g)
Commitees Paticpating n
O Joint Funckaising Rlepresentative [Unauthorized: h) Jomt Fundisises..,
Custodian of Records
I _Ed |
Treamner
I Edt | Agenis.
‘Website Addrezs [LURL)
| [ UL has changed
Primary e-mad Secondany e-mal DE-math
| | changed
Sigresd by
| D[:mnm::amm
haz changsd
Addeess has
O changed
Submizsion D g
- ok | Carcel |
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on Agents...

a. The “Affiliations, Agents & Banks Related to the Committee” dialog box will appear.

Affiliations, Agents & Banks Related to the Committee

I arne | Type | Title/Pozition

Designated....

Barnk. ...

Cancel

b. To add a connected organization, affiliated committee, leadership PAC sponsor, or joint
fundraising representative, click on Affiliation...

Affiliations, Agents & Banks Related to the Committee N 5’

[ Name Affiliated Committee/Connected Organization'

Name

m Edt.. |
* Connected Organization Delete |
€ Affiisted Committee oK |
" Leadership PAC Sponsor Cancel |

®, Joint Fundraising Representative

0K Cancel

FECFile Training Manual
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c. Select the name of the connected organization, affiliated committee, leadership PAC
sponsor, or joint fundraising representative from the list. (Note: if the name of the entity
does not appear, and press Tab or Enter to input its information.)

d. Under “Relationship Type”, select the corresponding type of relationship then click OK.
5. To add a designated agent (for example, an assistant treasurer), click on Designated...

a. Select the name of the designated agent from the list. (Note: if the individual does not
appear, type the name (last, first), and press Tab or Enter to input that individual’s
information.)

b. Enter the designated agent’s phone number and title/position with the committee, then
click OK.

6. To enter a bank/other depository, click Bank...

Affiliations, Agents & Bz x|
Name | Type | Title/Position add new
Banks/Other Depositories x| Affiliation....
Desighated....
Hame
i

Edi.... |
Phane Title/Fasition Drelete |

| | Ok, |
OF. I Cancel Cancel |

e Select the name of the bank/other depository from the drop down box. (Note: if the
bank or depository does not appear, type the name, and press Tab or Enter to input its
information.) Click OK.

7. To edit an entry in the “Affiliations, Agents & Banks Related to the Committee” screen, click on
the particular entry to highlight it, then click Edit.

8. To delete an entry in the “Affiliation, Agents and Banks Related to the Committee” screen, click
on the particular entry to highlight it, then click Delete.

9. After entering the information, click OK.
10. Click OK after returning to the “Statement of Organization” box.

FECFile Training Manual
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11. The Form 1 is now created. To view the Form 1 to ensure that it is complete, click the printer
icon in the top menu bar in order to see the committee’s information as it looks filled in on the
FEC forms.
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FECFile Basics

Saving in FECFile:

FECFile creates a committee database (with file extension .DCf), which holds the entirety of the
committee’s reporting history. This includes all reports, amendments, and contributors or vendors with
whom the committee works.

1. Save the file as often as possible. This will decrease the chance of massive data loss. Be sure to
save the file in a location easily accessible and easily remembered. Additionally, it is also
recommended that you back up the file to an external source, such as a flash drive, external hard
drive, or CD.

2. For each new report, open the same committee file. Do not create a new committee file each
time the committee files a report. This will lead to problems with election cycle-to-date
amounts, cash on-hand amounts, and aggregate amounts.

Using the Different Views:

FECFile is organized into seven different views or windows: Reports; Summary Page;
Individuals/Organizations and Events; Receipts; Disbursements; Loans, Debts, & Other Obligations; and
All Transactions. Each of these views displays a different aspect of reporting and is used to create and
modify both reports and transactions. There are three different ways to access a view:

1. When FECFile first opens, tabs will be displayed underneath the icon bar. Click on the tab to
access the desired view. Tabs can be rearranged by dragging them to another location on the tab
bar.

[8 FECfile - Manual Committee.DCF

File Edit Yiew Window Help

April 15 Quarter 9 - 03/31 /2009 01/27/2010 Davis, Sam 110542008 - 11 0.00 0.00

July 15 Quarter 19 - 06/30/2009 Davis, Sam 11/05/2008 - 11 0.00 0.00

F3L - July Montt 9 - 06/30/2009 - 11/0542008 - 11

October 15 Que 9 - 09/30/2009 12/07(2009 | Davis, Sam 11/05/2008 - 11 0.00 29441.71
48-hour notice { - 10/01/2009 Davis, Sam 11/05/2008 - 11

A1:50:April 15 (10 - 03{31/2010 0471642010 Davis, Sam 11/05/2008 - 11 29441.71 154441.71
July 15 Quarter L0 - 06/30/2010 Jones, James  11/05/2008 - 11 154441.71  161441.71
Fz2 - - 11/05/2008 - 11

48-hour notice ( - 042002010 Davis, Sam 11/05/2008 - 11

FECFile Training Manual
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a. In order to view two tabs side-by-side, right-click on a tab and select Open in a
Horizontal Tab or Open in New Vertical Group.

[5 FECFile - Manual Committee.DCF

File Edit Wiew Window Help
— = = — .
] 885wl .0
= -2 ElY o

LE=EE

=1k

Individuals/Organizations and Events - r Reports r Receipts r" .‘a’){ Lo mmﬂv]
Line# | Mame | Date | Balance | Total | I..| P.l Open in Mew Horizontal Group

Cpen in Mew Wertical Group

Cancel

[2 FECfile - Manual Committee.DCF
file Edt Yew Window Help

m L Aol = Bl B M= % ' @ — m 5 | 0
VOl &2 5] L] " - S >
Individuals/Organizations and Events - | Reports x| ther Obligations | Ed Receipts x|

Lne# | Name | bae | Amount | Aggregete | L P Line# | Name | bae | Amount | Aggregete | L/ P

170 John's Hardware 725/2009 7463 .63 128 11z} smith, Joe 9jzzfe0ns| 480000 480000018

7 Janes, James 0910/2008 4s64S 45645 LIT [M21¢a) | Smith, Joe 8fzzfzns 240000 480000120 L18

20(s)  Johnson, Joseph 07j2/2009 150000 1500.00 L3t 13(z)jh  Swith, Joe 03/24/2009 2500000 23800.00 136

17y USPostmaster 0914/2009 0624 10624132 11z} Davis, Sam 09152008 200000 2000.00108

7 Credit Card Company Di04/00s 2477AT ZATRAZLH [M]21(a) | Smith, Jane O8fzzfe008  2400.00 0.00121 118
11z} Jones, James 09/10/2008 45645 4S6dS LIS
11(s} | Johnson, Joseph oFf12}2009 1800,00 1600.00 130

b. Tabs can be closed by clicking on the “X.” New tabs can be opened or re-opened by

using the “View” menu or clicking on the appropriate icon (see next page for FECFile
Views).

2. Under the “View” menu, select the desired view:

Eile Edit |giew Wwindow  Help

L

Individuals/Organizations
Election Cycles

— Reports
ndiv

all Transactions
| Type

April 15 QL Surmary Page

July 15 0u Receipks

F3L-July | Dishursements

October 15| nans and ather Obligations

48-hour nc

AL:S0:Apr - Recyele bin

Jly 15Qu- oy bl
Fz

Search, .. Ctrl+F

45-hiour nc

3. Click on the icon, located across the top of the screen, representing the view:

Q08 &

FECFile Training Manual
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About Each FECFile View:

1l

Reports View — This view lists all reports created in the committee file. Transactions on these
reports can be modified if the report is “open” (see page 27). Reports also can be amended
using this view by right-clicking on the report and selecting Amend.

Summary Page View — This view shows both itemized and unitemized totals for each line
number in both the period covered and the election cycle. Transactions may be entered on line
numbers by double clicking a line.

Individuals/Organizations and Events View — This view lists all entities entered into the
committee database, including the committee’s information, contributors, other political
committees, businesses, etc. Modify an entity by double clicking on it.

Receipts View — This view lists all receipts entered in the report currently selected in Reports
View. Modify a transaction by double clicking it, or right click an entry for a list of options
such as creating a new transaction, deleting a transaction, adding memo text, etc.

Disbursements View — This view lists all disbursements entered in the report currently selected
in Reports View. Modify a transaction by double clicking it, or right click an entry for a list of
options such as creating a new transaction, deleting a transaction, adding memo text, etc.

Loans, Debts, & Other Obligations View — This view lists all debts, loans, or other obligations
that are owed to or by the committee in the report currently selected in Reports View. Modify a
transaction by double clicking it, or right click an entry for a list of options such as creating a
new transaction, deleting a transaction, adding memo text, etc.

All Transactions View — This view lists all transactions entered in the committee file.
Transactions are sorted by line number and name.

Memo Text:

Memo text is used to provide additional information regarding reports and transactions. Memo text can
be added by highlighting the report or transaction, right-clicking, and choosing Memo Text... from the
available options.

Working with Contributors and Vendors:

FECFile creates a database for all entities (individuals, businesses, PACs, Political Party Organizations,
etc.) within the committee file. This saves the committee from repeatedly entering the contributor or
vendor information if a committee conducts multiple transactions with a particular entity.

There are two ways to create an entity:

1. When entering the first transaction associated with an entity, make sure the cursor is in the
“Name” field and press Tab or Enter. The “Individual/Organization Information” window
will appear.

2. Using the Individuals/Organizations view, right click anywhere in the workspace and click
New from the available options. The “Invididual/Organization Information” window will
appear.

FECFile Training Manual
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Filling Out the Individual/Organization Information Box

1. Select the correct entity type from the drop down menu at the top of the window.

e Note: FECFile disables any field that is not required for a type of entity.
2. After entering the information, click OK.

Using the FEC “Lookup” Feature:
Click Lookup...

political committee.

1. In the “Individual/Organization Information” box, click

Lookup...

2. The “FEC ID Lookup”
window appears.  Scroll
through the list and click

once on the entry to
highlight it.

3. Copy all applicable
information by clicking
Copy All....

4. Unchecking boxes in the
window that appears will
exclude that information
from copying to the entity

Individual /Organization Information

to access the FEC’s database of federally
registered candidates and political committees. Use the feature to
save time when entering information for a federal candidate or

Type

Campaign Canimithes

Cammittee 1D [eg. C1

T |f Committee/0rganization

[~ Wational

FEC ID qukup |
Committes/Candidate Mame I Ca... I Ca I Ca... | C-: | Carmmittee. . | Other 1D | -
FRIEMDS OF GU'Y PARISI H H CO0288495  H4MY19032
FRIEMDS OF HANK SAMDERS H AL H AL CO0257683  H2ALD7025
FRIEMDS OF HEIDI FOR COMGRESS H Wi H Wity CO0338145  Hewals043
FRIEMDS OF HEMRY F WOJTASZEK H MY H MY CO0380089  H2Mv28102
FRIEMDS OF HERMAM CLARK FOR CONGRESS H Ga  H GaA CO0257162  H2GADEO32
FRIEMDS OF HIGHER EDUCATION INC [ ]

FRIEMDS OF HILLARY 5 95 SOMYO0188
FRIEMDS OF HOLLEMBECK, FOR COMGRESS H il H [l CDDBEHB?B HOMI04074
FRIEMDS OF HOUSEMAN FOR CONGRESS H IN H IN CO0308445  HEIMD4034
FRIEMDS OF HOWARD MILLS 5 MY 5 MY CO0397331  S4MY0O156
FRIEMDS OF HOWELL HEFLIN COMMITTEE 5 AL S AL CO00B5951  SE&ALO00S0
FRIEMDS OF HUMTER SMITH FOR CONGRESS H co H CO  CO0335786  HBCOO1048
FRIEMDS OF [SAKSOMN 5 Ga 5 GA CO0392340  SEGADOT19
FRIEMDS OF ISRAEL | MY CO0265470

FRIEMDS OF ISRAEL POLITICAL ACTION COMMITT... o} Ca o COO141747

FRIEMDS OF JACK KINGSTON H Ga  H GA CO0261958  H2GAODT157
FRIENDS OF JACK MACHEK H P& H P& CO0352260 HOPAD4204
FHIENDS DFJACK DF!CHULLI 5 CT § CT  CO0334882 S4CTO0146 ;I

reCOfd. CIICk OK and a” Prev | Mext k Copy &ll ... 1 Copy ID I Cancel
of the committee’s
checked information will

x|

be copied into the entity record.

Click OK to return to the transaction screen.

Name : [v IFHIENDS OF HILLARY

Address 1: ¥ |1?1? K STREET Mw/ SLITE 3094

Address 2: W I

City : [¥ |WASHINGTDN

State: v |DE: Zip: ¥ |20035
Candidate infarmation
( Office: b |5 State : v INY Distiict : W |uu

o]

Cancel |
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Recelpts

FECFile Video Tutorial: ""Entering Contributions from Individuals and PACs"

Receipt Basics

1. Click the “Summary View” icon at the top of FECFile. In the “Summary Page” window, double
click on appropriate Line to enter a transaction.

{8 Summary Page - Form 3

Line# | Description ThisP. I This.U | CTDLI cTo.u |
11a) Individual Contributions 5600, 00 5600, 00

Contributions From palitical thees 000,00 000,00
11{c) Cantributions from ather political cammittees 10000,00 10000,00
11id) Contributions from the candidake
12 Transfers from other authorized committees

13(a) Loans received from the candidate

13ih) Cther loans received

14 Offsets ko operating expenditures (refunds, rebates, etc 1400.00 33.45 1400.00 33.45
15 Other Receipks (Dividends, Inkerest, etc.) Z045.00 187.68 Z045.00 187.68

2. Click on the name in the list scroll box immediately beneath the name field if the entity already
exists in the committee’s FECFile database. If the entity is not in the database, press Tab or
Enter to add the information. Refer to page 14 for more information.

3. Enter date and amount and any applicable description of the transaction (“partnership”, for
example).

4. Enter the election and year of election for the contribution.
Click OK.
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Special Categories of Receipts

In-Kind Contributions

When entering an in-kind contribution, click the “In-Kind” box

shown at right and add a description.

Note: Checking the “In-

Kind” box will automatically create the necessary balancing entry
on Schedule B. Use the “Description” field to add a description of

the in-kind received.

Reattribution/Redesignation of a Contribution
Go to the “Receipts” view.

W & Receipts

x
Hare
[roheaon, Joreph
Jiohe's Harchoare - 343 Dogreood Lare -
Johnson, Joseph - 3837 Wesprg Wilkow [irve..
Jones, James - T2 7 Dk Tres Cout -
Date Burund
[rrzms [ Z000,_F Infind
Diegenphion
Jirvkand - Fioad o hunehaises
Ebecton Yo dElection [ pemo
[Frecsy =][am0

F Agpegats
Conmtiee

1. Find the contribution to _
reattributed or redesignated and e e
right click on it. Mouse over the [iia) New... Ins 2000.00 109
“Redesignate/ Reattribute.,” Then |!i(¢) nes dsne Mol il el Sl
click Reattribute or Redesignate in Clone...
the box that appears. Transaction Spik..

Loan/Debt payments,.,

2. After_ choosing Reattrlbut(? qr _ ?I
Redesignate, enter the correcting information =
for the transaction and click OK. Note: Name
Remember to cross reference by including the |Smith, Joe
name of the original contributor in the Smith, Jane - 536 Eln Strest.. B

description field. Click OK to return to the
“Receipts” view.

Smith, Joe - 536 Elm Street...

Date

Armnount

|8/22/2009
T

-2400.00 IT ki

Redesignate: Jane Smith 8/22/05

lection F Memo

IP:imaly

r
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a. For reattribution, highlight the newly created negative entry that FECFile generated for the
original contributor, then right click and click Modify...

[B Receipts = |I:I|£|
Line# | Name | pate | Amount | Aggregate |L.[P. |k
11(a)  Smith, Joe 08/22/2009 4800.00 4800.00 118

[M]t1(a) Smith, Joe 08f22{2009 -2400.00 4800.00 120 118

11(a)  Davis, Sam 09/15/2009 2000.,00 2000,00 109

11{a)  Jones, James 09/10/2009 456,45 New... Ins

Modify. .. Ctri+m

b. Update the description field to include the name of the person to whom the contribution is
being reattributed.

Click “OK” and then click “Yes” at the prompt.

48-Hour Notices (Form 6)

1.
2.

A 48-hour notice is a separate filing from a Form 3.

To prepare to create 48-hour notices, first create the Form 3 that includes the 48-hour notice
period.

To create a 48-hour notice, go to the “Reports” S
view, right click, and click New. Click “48-hour @ @

notice (Form 6)” and click OK. 8]' [None ~|

The “48-hour notice (Form 6)” box will appear; f@

fill in the election date, the state, and enter the T —————— —
treasurer’s information in the “Signed by” box. Johnison, Joseph - 3837 Weeping Willow Diive. :f
All fields are required. Jones, James - 3217 Ozk Tree Cout =

Click OK. Note that at this point the notice is ok | Cancel |
not complete.

Select the “Reports” view and select the 48-hour
notice by clicking on it.

Select the “All Transactions” view and locate the receipt(s) that needs to appear on the 48-hour
notice. Receipts will be sorted by line number and then alphabetical order.

After finding a transaction, select the entry, right click, and click Add to Form 6. (See next page
for example.) Repeat this step until all the required contributions have been added to the 48-hour
notice.
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[E all Transactions

Name

11{a) Davis, Sam

10(a)  Jones, James

11{a) Smith, Jos

17 Jones, Jahnes

[M]L1(a) Senith, Jane

[M]11(a) Sensth, Joe
Transaction Spit.,
LoaniDebt payments.
Memo Text, ..

fedesignate Reattribute. .. »

Forghve/oetie. .,

Closs Flenoet, .
Bmered

The 48-hour notice is complete. Close and upload it in the same manner as a regular report of receipts
and disbursements (see page 28).
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Bundled Contributions

Select the “Reports” view and create a Form 3L
(Report of Bundled Contributions). Select the
correct report under “Type of Report,” and input
the treasurer’s name in the “Signed by” box.

Once the Form 3L is created, contributions can be
added to it by checking the “F3L Bundle” box
while entering contributions to the Form 3.

. To specify the bundler, select the
Lobbyist/Registrant  from the scroll  box
underneath. If the Lobbyist/Registrant does not
appear, type the name in the “Lobbyist/Registrant
Bundler” box and hit Enter or Tab, and then input
the necessary information.

. The Lobbyist/Registrant will only appear on the
Form 3L if the total activity attributed to them
exceeds the itemization threshold during the
coverage dates of the Form 3L.

Close and upload the Form 3L in the same manner
as a regular report of receipts and disbursements
(see page 28).

Report information x|

Individual Contribution x|
Hame

Type of Report

I October 15 Quarterly ;]

Date From Date Thiu Election date

|7/1/2009 |9/30/2009 |

State District Semi-annual Period ——

INone ;I I  Jen - Jun 30

r This report discloses a new € Jup T -Dec 31
committee address % None

Signed by

IDavis, Sam

Dawvis, Sam - 746 White Dak Stieet..
Johnson, Joseph - 3837 Weeping Willow Drive...
Jones, James - 3217 Oak Tree Court... L’

| 0K I Cancel

[ehnzon, Jozeph

Joba's Hardwae - 343 Dogwood Lane -]
Johigon, Joseph - 3837 Wespmg Willow Dinee.., =
Jeres, James - 3217 Dak Tree Cout |
[
|ETEETT] | 20000 [ Inkind
Dnik
I
Eleclicn Yes ol Elecion [ pemo
Frimary =|f2010
| JI W Aggegate
Candidate,/ Campagn Commkies
|
Joe Senth for Corgress - 1855 Maple Averie., EI
Computers PAC - E49 Magnola Trad. ..
Simith, Jo& - 536 Ekn Stiset.. hd
ottt/ Flegistiant Bunde
ComptErs PAE—

Laiegony coda

I F4|
Check Mo, Account |dentfier

I 1

gt ecty.. | [ ok ] come
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Tips for Reporting Receipts

1. FECFile automatically itemizes contributions according to the thresholds outlined in the law. By
entering a record for each individual who contributes to the committee, regardless of the
contribution amount, FECFile can track aggregate election cycle-to-date totals more effectively,
and, if a contributor crosses the $200 threshold, itemize that individual.

2. To report an offset to operating expenditures, please include additional text in the “Description”
field indicating “Refund,” “Rebate,” etc., as well as the original date of the corresponding
disbursement.

3. The check number and account identifier are NOT required fields and do not show up on a
report. However, providing this information will allow the committee to keep better internal
financial records.

4. The “Aggregate” box should remain checked so that transactions aggregate on an election cycle-
to-date basis.

5. Memo entries can be used for any transaction requiring supporting information, and when the
amounts should not be included in cash on hand totals.
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FECFi

Disbursements

le Video Tutorial: ""Entering Operating Expenditures and Staff Reimbursements'’

Disbu

rsement Basics

1.

17
15
19(a)
19(b)
200a)
200k
200
21
21

Go to the “Summary Page” view and double-click on the appropriate line.

Operating expenditures 10510.34
Transfers to other authorized commitkees

Loan repayments made to the candidake
Other loan repayments made
Refunds of individual contributions 1000.00
Refunds of contributions Fram palitical party commitbees 5000.00
Refunds of contributions From other palitical committees 15.00
Other disbursements 15000.00
Loans made
x|
A disbursement box for that line number will @
appear.
PP IJWSrn-!hI-:u Congress - 1865 Maple Avenus ﬂ
) Computess PAC - B49 Magnobks Tiad
Select the payee’s name from the scroll box below Dave, Sam- 746 Whde Ok Svee <

o

the “Name” field. If the entity is not in the (Doe)  (amom)

database, press Tab or Enter to add the =S iy 000 I int
information. (ﬂ@

Complete the date, amount, description, and all [

other applicable fields. r""“ j{x“"““"’" ™ bewo
Click OK.

Special Categories of Disbursements

Reimbursements and Credit Card & Payroll Payments:

Payments to credit card companies, payroll companies, and reimbursements all need to list supporting
memo entries to disclose the ultimate recipient of the funds.

1.

Double-click the desired line of the Summary Page and enter the entity receiving the
reimbursement or payment. In the description field, provide an acceptable description, such as
“Reimbursement,” “Payroll payment,” or “Credit card payment.”

Go to the “Disbursements” view and find the transaction that needs supporting memao entries.
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3. Right click on the transaction and click Transaction Split.

Line# | Mame | Date | aAmount | Aggregate | I P.|
20(s)  Johnson, Joseph 07fz2{z009 1500.00 1500.00 131
17u Johr's Hardware 072612009 74.63 74.63 128
17u LS Postmaster New... Ins 106,24 132
17 Jones, James Madify... Chrlm 456.45 117
Delete Del
Clone

Transaction Splt

LoarifDebE payments .
Mema Text...
RedesignatelFeattribute. .. 13

Forgivefsette, .

4. Click Add new....

5. A new transaction window will open. Fill out the original vendor’s information and click OK
when finished. (Note: the “Memo” box is grayed out as the transaction will automatically appear
as a memo entry.)

I [ Hame [ hmors | Date

x|

_Addrm. |

opcr ot Expenditure T
_ Dawe |

Hare
T e w— Cowe |

Ciremn, S - P46 wihite Clak Shest ﬂ
i

Jor's Hardeame - B0 Dogeood Lane
Jodwon, Joisch. - SENT wesparn illows Deres

Dt Bumieird
i | ETRTE] | 24 73 (I R |

[Dhescrphon
[P office ko

6. Repeat this process until all of the supporting memo entries for the payment or reimbursement
have been entered.

7. After entering all of the supporting memo entries, click Close to return to the “Disbursements”
view.

FECFile Training Manual
Page 23



Debts and Loans

Schedule D: Debts

Debts Owed by the Committee:
1. Select the “Summary Page” view.

2. To add a new debt owed by the committee, double click on Line 10 (Other Debts Owed BY the

Committee).
(0 summory Page Form ol
| Lne# | Description | mepl | TheU | cDX | cTOM |
11(a) Individual Contributions: Q05645 056,45
11(b)  Contributions from poltical party committees
1y Contributions from other political committess
10(d)  Coritributions from the candidate
12 Transfers from other authorized committess
13(a)  Loans received from the candidate
13(b) Other Inans recetved
14 Offsets to operating expendiures (refunds, rebates, etc
15 Other Recespts (Dividends, Interest, etc.) =
x
17 Operating expenditures 293
18 Transfers to other suthorized committess Name

1908} Loan repayments made to the candidate |

19(b)  Other loan repayments made

20(a) Refunds of indrvideal contributions 150
20(b) Refunds of contributions From poltical party commithees

20(ch  Refunds of contributions from cther political committess

Joe Smith foi Cangress - 1865 Maple Averue...
Computers PAC - 649 Magnolia Trail .
Coedit Cand Comparny - 24836 Cherrwood Stiest.,

21 Other dishursements a Amount = Saitied e
21 Loans made F = [ ﬂfﬁ* 2 L
23 Cash on hand Description
9 Loans owed TO the committes |
9 Othisr dishts owed TO the comimittes Jection mction
10 Loans oxed BY the committes r qesol
Other debts owed BY the commithes | I ﬂl
Candidals

Joe Smith for Cangress - 1865 Maple Averns..,
Compulers PAC - 543 Magnokia Tral .
Smith, Joe - 535 Elm Shest..

N&ﬂ*ﬂyl | 0F. I

3. Select the name field and enter in the debtor. If the vendor has not been added to the system,

press Tab or Enter.

4. Enter the date, amount, and the purpose of the debt in the appropriate fields.

Click OK.
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Debt Repayments:

1. To add debt repayments, go to the “Loans/Debts” view.

2. Right click on the debt to which you would like to make a payment and click Loan/Debt

payments.

Bank Cerfer First
Capkal Party

02202004
Few...

Mesdify...

Dt

Clone...,

Redesgnate/Reattribute, .,
Fargive/Settle. ..

Ins
Cbrbem
Dl

137800.00

. Mem:lim

K

Iose Regort

Sort...
Itemization

bkt

In the “Loans/Debt payments” box, click on Add new....

4. In the “Select the type of Deferred Disbursement” window, click on the line number the payment

will go on, such as Operating Expenditure [17].

5. Enter the name of the vendor, date, amount, and the purpose of disbursement.

Click OK. The debt payment should now appear in the “Loan/Debt payment” dialog box.

Click Close.
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Schedule C & Schedule C-1: Loans

Loans Received:

1.

Go to the “Summary Page” view and double click on
Line 13(a): Loans received from the candidate or
13(b): Other Loans Received.

Type the name of the creditor in the “Name” field. If
the creditor has not been entered into the system
previously, type the name and then press Tab or Enter.

Enter the date the loan was incurred, amount of loan,
interest rate, election type, year of election, and the
loan’s due date.

If the loan was secured, check the “Secured” box. The
committee may also add a description of the loan in the
“Description” field.

If the loan is from the candidate’s personal funds,
check the “Personal Funds” box.

If the loan is from the candidate and derived from a
bank or some other source that is NOT the candidate’s

Loan Made or Guaranteed by the __J__f_;_ da x|
Name
fi

Joe Smith for Congress - 1865 Maple Avenue... il

Computers PAC - 643 Magnolia Trail...

Credit Card Company - 34836 Cherywood Street... L'
Date Amount Interest Rate(%)
| | 000 |
Description
Election Year of Election Due date
| =l I
[~ Secured I™ Forgiven Schedule C1...
™ Memo I Guarantors...
[~ Personal funds

Next entry.... | | 0K I Cancel

personal funds, click Schedule C-1... and enter all information that is applicable to the loan.

If the loan is received directly from a bank or lending
institution, click on “Schedule C-1...” and enter the
required information. Note: If the committee receives
the loan directly from a bank or lending institution,
the committee is required to file a paper copy of
Schedule C-1 with the signature of the
representative from the lending institution and the
treasurer’s signature, as well as a copy of the loan
agreement.

After completing this section, click OK.
If there are any guarantors, click Guarantors...

10. Click Add new... to enter guarantor information. Click

Edit... if the guarantor has been added previously.
Click OK to return to the “Loans Made” screen.

Schedule C1 ! x|

Lending Institution
Iana! Bank

Date Incurred
|9/23/09

US Postmaster - ..

Al
Local Bank - 1859 Cheny Tree Cicle... s

=] [ersraonz

Loan amount Interest% APR
|50000.00 jo.00

[ Loan has beenrestructured  Original date l

Credit amount this draw ~ 3utstanding balance if line of credit

Jo0o {o.00
™ Othes parties are secondarily liable

Traditional collateral pledged |
Value Description [~ Perfected interest ‘
[o.00 |
- Future income pledged
| Pledge account Value |
[ [0.00 '

Credit Card Company - 34836 Chernywood Street... & .
John's Hardware - 943 Dogwood Lane... g Established on
Local Restaurant - 1812 Plum Tree Drive.. i

Desciription ]
Altemate basis for loan and repayment

Authorized By Tite

Davis, Sam - 746 White Dak Street... =D als s
Johnson, Joseph - 3837 Weeping Willow Drive... A i

Jones, James - 3217 Dak Tree Court LI ]
0K I

Cancel |
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Guarantors - Schedule C2 =

Guarantor | Smount
Ok |
Cancel |
4| | ]

11. After the loan information is entered, click OK to return to the “Summary Page” view. Schedule
A supporting Line 13 and Schedule C supporting Line 10 will now have amounts reflected on the
Summary Page and the corresponding schedules will be created on the report.

Loan Repayments Made:

1. Go to the “Loans/Debts” view. [Loan Repayment to Candiiat SRR x|
2. Click the loan for which repayment is being made, right Name
click, and click Loan/Debt payments... |Smith. Joe
Srith, Jane - 536 Elm Street.. ]
Click Add New... TR T =l
4. Enter the creditor’s name; if the creditor has already Date Amount

been entered, select that name. Type the date, amount,
and enter “Loan repayment” into the “Description”
field.

Click OK to return to the “Loan/Debt Payments”
screen, then click OK to close that window. Schedule B
supporting Line 19(a) or 19(b) and Schedule C
supporting Line 10 will now have amounts reflected on
the Summary Page and the corresponding schedules
will be created on the report.

[3/29/09 | 25000.00 I Inkind

Description

|Loan repayment
Election
| Primary

Year of Election
~||2md
Candidate/Campaign Committee

I Memo

Computers PAC - 649 Magnolia Trail...
Smith, Joe - 536 Elm Street...

Lobbyist/Registrant Bundler

Joe Smith for Congress - 1865 Maple Avenue... ﬂ
=

I~ F3L bundle

Computers PAC - 649 Magnolia Trail...
Davis, Sam - 746 White Oak Street...

Category code

I =

Check No. Account [dentifier

Joe Smith for Congress - 1865 Maple Avenue... g
=l

ezt entry,
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Closing a Report

Closing/Uploading/Amending

1.
2.
3.

Validating and Uploading a Report

L L [ = o = B [ =

Go to the “Reports” view.

Close Repott. ..
o
EiT=imin

Right click on the report and click Close Report.

Enter today’s date in the “Date closed” field and click OK. x|
(Note: a Filing ID is only required when filing amendments Dato olosed
and should be left blank for new reports.) |‘—;[

Cancel |

1.

First, follow the directions above for closing a report. (Closed
reports should appear in pink/purple in the “Reports” view)

ipeil 15 Cusanterly 01/01/200% - 03/31/2009
A1:50: July 15 Quartarly 04/01 {2009 - D5f30/2009
F3L - July Monkhiy [Semi-annual D (1T o B
October 15 Quarterhy 0701 f200% - 033002009

4i3-hour notics (Form &)

IMPORTANT: Save the file before validating and uploading!

Click Validate in the “File” menu or click the Validate icon, which looks like a card with a check
mark, along the top of the program.

The validation program will notify the user if there are serious errors that will prevent the report
from being accepted by the Commission. For more help with Validation Errors, please see page
32.

X

@ This filing has errors that will cause it to be rejected by the electronic-filing server, Please correct these errors before Filing.
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Note:

A report that has errors will not be allowed to upload. A report with warnings will

upload, but be advised that warnings indicate some missing information that may be required. If
no errors are found or the user wishes to file the report with warnings, then click Upload from
the “File” menu, or click the Upload icon, which is located directly to the right of the Validate

icon.

Enter the password (see page 2), 9-
digit committee ID number, and
email address. You must confirm
the password and email address by
entering them a second time or the
report will not upload.

Unless otherwise directed by the
FEC’s Electronic Filing office or an
FEC analyst, leave TCP/IP as the
Filing Method and then click OK.
(Note: “This filing amends” field
should not be filled in for new
reports.)

Upload | Eonfigurel

 Filer information

(2.0 C123456785)
(.0 2022190674)

Fax I

Confirm I [caze-zenzitive)

Pazsword I

a-mail 1 I Carnfirrn | (2.0 johndoef@emte. com)

Canfirrn | [e.g jahedoe@emte. com)

e-mail 2 I

— Filing kethod

& TCPAP {551  Dialup L B © Other

™ Filer it b thee best zerver [ will not be received by the agency |

Thiz filing amendz I

Save the committee file after the

Cancel

o ]

Help

report uploads.

Amending a Report

Creating an Amendment:
1. Go to the “Reports” view.
2. Right click the report to be amended and th
3. Click OK on the “Report Information” box.

en click Amend.

a. Note: reports originally filed on paper before the committee crossed the electronic filing
threshold cannot be amended electronically.

The report will now have an Al, A2, etc. in front of it. Al is for the first amendment, A2 is

for the second amendment, and so on. If the user has filed any reports with coverage dates
following the amendment, FECFile will automatically generate amendments for those
reports. For instance, if the April Quarterly report is amended in November, FECFile will
also generate amendments for the July Quarterly and October Quarterly reports.

Note: these reports will automatically be generated, but not automatically uploaded. Also,

these additional amendments need not be uploaded unless there is a change in any of the
dollar figures (most commonly: election cycle-to-date, cash-on-hand totals, or aggregate
totals). If there are any changes in the dollar figures for subsequent reports, please upload

those reports as well (see page 28).
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Modifying Transactions for the Amendment:
Fecite X

‘:.T/-‘ Are wou sure you want to modify the selected Repork?

1. Locate the transaction to modify.
2. Double click on the transaction.

3. Make the desired changes to the transaction and = No__|
click OK.

4. When prompted, click Yes to modify the selected
report.

Adding New Transactions for the Amendment:

As with a new report, go to the “Summary Page” view and double click on the appropriate line
for that transaction.

Deleting Transactions from an Amended Report:

1. Locate the transaction to delete. ecfile X
2. R|ght CIiCk on the transaCtion and CIiCk Delete- '?/ Are you sure you want to delete the selected transaction?

‘_‘_t

3. When prompted, click Yes to delete the selected

transaction. ves [ mo |

Filing an Amended Report:

1. Anamended report is filed like a new report: Close the report, and then choose Upload from the
File menu.

2. If the original report was created using FECFile, the x|
software will automatically fill out the “Filing ID” field.

Date clozed
[1/15/08

Filing 1D [Qriginal]
FEC-123456

a. Do not alter this number unless instructed by an
FEC analyst or the FEC’s Electronic Filing Office.

b. If instructed to alter the number, or if the number Ok I
does not appear in the box, the filing ID is located
on the FEC’s Electronic Reports Retrieval website.
Type in the committee’s ID number and click Send
Query to find your committee’s electronic filings.

http://www.fec.gov/finance/disclosure/efile search.shtml
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Secrets to FECFile

Common E-Filing Mistakes!

Passwords
e Remember to obtain a password as soon as possible.

e Don’t wait until the last minute to apply for a password or to apply for a new one if necessary.

e Remember the committee’s password and keep it secure: the FEC cannot look up misplaced or
forgotten passwords; the Treasurer must request a new one.

Filing at the last minute

e Any problem, whether it’s technical or non-familiarity with the software, can be difficult to deal
with during the rush of a deadline week. It is advisable to always file as early as possible, especially
the first time the committee files electronically.

Email receipts confirm filing has been received.

e After uploading the report electronically, a receipt will be sent to the email address or fax entered
when uploading the report. Assume that the report was not successfully filed if no receipt is
received. Call the Electronic Filing Office (202-694-1642, Option #3) if more than a few minutes
pass without receiving a receipt.

e The receipt is proof of filing. Print it out and keep it.
Save and validate data set early and often

e Doing this through the process of report creation will ensure proper and consistent data entry as well
as preventing the loss of work due to unforeseen computer problems, i.e. freezes, crashes etc.

Back up the data file!
e The file that contains all of the committee’s reports, the “Data File” (*.dcf), should be backed up to
an external source.

e Itis very difficult and time consuming to recreate the committee file if it is lost.
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Common Validation Errors and How to Fix Them

Warning vs. Error Messages
There are two different types of validation errors: warning messages and error messages.
Warning messages:

These messages are a result of possible incorrect/missing information in the report so the user can
correct the issues (if necessary) before uploading the report. However, they do not prevent the
committee from uploading a report.

Error messages:

These messages result from more serious problems with the report and prevent the user from uploading
the report until the errors are corrected.

Reading and Understanding a VValidation Message

Each warning or error message contains basic information that allows the user to pinpoint which
transaction is causing the issue. It also gives a brief description of the error. For example:

Form{ltem}: SA11Al {Johnson, Jane}
Field Name: #012 Employer
Warning  Conditionally Required Field is Empty

The Form {ltem} field identifies where the transaction causing the error is on the report. In the
example above, the transaction is on Schedule A, Line 11(a)(i) and is specifically identified as “Johnson,
Jane.” Field Name identifies the aspect of the transaction — in this case the employer field — that is
causing the problem. The last line identifies what type of message this is (Warning) and describes what
caused the problem (Required field is Empty).

In order to correct this problem, the user should find the specific transaction and edit it to disclose Jane
Johnson’s employer.

The FEC’s website includes a more extensive list of commonly found warning and error messages along
with brief descriptions and solutions.

http://www.fec.gov/support/fag valid.shtml
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Common Error Messages

Below are a list of common error messages that committees encounter and the steps that need to be
taken in order to correct the errors. Please remember that all error messages must be corrected before
you can upload your report.

Filing must be in the current FEC format
e This indicates that you are using an outdated version of FECFile.

e FECFile users will need to download the latest version of the software from the FEC's website
(http://www.fec.gov/elecfil/updatelist.html).

Amended filing must have an ID of the "*Original**

e This indicates that the user is trying to submit an amendment absent the original report ID
number. The original report ID number must be used. If you are properly amending existing
reports in the committee file, the original filing ID should appear automatically.

e If the user cannot locate his receipt for the original report, the ID number can be located on the
FEC's Electronic Filing Report Retrieval website (see below)
(http://www.fec.gov/finance/disclosure/efile_search.shtml).

View Download FEC-393203 Form F3A - period 10/01/2008-10/15/2008, filed 01/13/2009 - PRE-GENERAL
View Download FEC-393173 Form F3A - period 07/01/2008-09/30/2008, filed 01/13/2009 - OCT QUARTERLY
View Download FEC-390718 Form F3N - period 10/16/2008-11/30/2008, filed 12/04/2008 - POST-GENERAL

e Once you have located the original filing ID (F3N), you will need x
to open, and then re-close your report so you can enter the filing Date closed /m
ID (see right). [ ~dgeciatess__/
e NOTE: If this original report ID number is entered incorrectly,
system errors will occur on upload. ok | Carcel_|

Amended filing must have an *"Amendment Number**

e This means that either the GG =
amendment indicator is missing or

incorrect. The first amendment
will be Al, and each subsequent

| E Yol have nok uploaded the report that is being amended. Would you like to conkinue?
-

. . |
amendment will be numbered in ok |[_concel ]
sequence.
e This error most likely occurred m'f“ e
A Y Chrl+m
because you did not properly create an amendment or Delete Del
amended a report before it was filed. e
fFarm F2-1.,
e Don’t amend a report that you have not uploaded. FECFile Laan/Debt payments...
1 1 1 H Merma Text,..
will warn you with this message — click Cancel. ederite ot ,
Fargive/Settle.
| ESE ;eiort. oo
anual
S0tk ., CErlHr
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e In the “Reports” view, right click on the report you are trying to file. If the report is closed,

unclose it. Right click again and click Unamend.

e Repeat this process until your report is at the correct numbered amendment

Validation terminated! — Over 32,000 problems found!

e This indicates that 32,000+ errors have been found. The threshold for total errors for the system
is 32,000; therefore, the first 32,000 errors will be listed in accordance with their severity.

e If you receive this message please contact your reports analyst or the FEC electronic filing

office.

|D# NOT correct FEC ID# format

e This indicates that the committee ID number
used is not in the correct format.

e To correct this error, you will need to edit
your committee’s information. To do this,
go to the “Individuals/ Organizations” view
and locate your committee. Double-click on
your committee entry (it should be in red).
Make sure the committee ID number is
correct. It might help to use the FEC
Lookup feature.

Mame |

Public Communications

Exempk Political Action Committee - FILER
Woker Drive

Adrminiskrative Type

Doe, John

FedE:x-Kinkos IF'u:uIitiu:aI Action Committes

HERSETH, STEPHAMIE
HERSETH FOR COMGRESS
Johnsan, Jane

SDARA DA AL

- a C12345676)
COD336345 Lockup...|

e NOTE: (correct example: C00123456) - The “C” must be capitalized.

{Field} exceeds maximum length of

e This indicates the user has exceeds the maximum number of characters allowed in a particular

field

e This should not be a problem in FECFile because it will automatically limit the number of

characters you can input

{Field) is required, but field is empty

e This indicates that information is required to be entered in a particular field, but has not been.

e Locate the transaction and fill in the field.

Extraneous data follows last field
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e This usually indicates a technical problem, generally involving invalid characters.
e You should call the Electronic Filing Office if you receive this error (202-694-1307).

e NOTE: Only characters between ASCII 22 and ASCII 126 are acceptable. The ASCII 32 - 126
used to be the only characters allowed; however, the foreign language alphabet and punctuation
characters are also allowed. Specifically ASCII characters: 32 - 168 are allowed (excluding 127
and the series 157 through 159). Also, 173 is allowed.

Invalid double-quote surround text field — OR - Embedded double-quotes (**) not allowed
e This indicates that there are a set quotes around a text field where there should not be.
e Locate the transaction/field and take out the quotes.

e NOTE: Quotes are used as part of the data delimiter. Since the introduction of a level-8
message that says "Embedded double-quotes (") not allowed", this message only applies to the
very last field of a CSV string and only in the instance where a begin-quoted text is not
terminated with an end-quote. (Example: falling within the maximum length of that last field.)

e ADDITIONAL NOTE: Any field can have begin/end quotes (they are necessary for text that has
embedded commas). However, any field that has surrounding quotes may not also contain
double quotes anywhere within the text. Validator is only trapping "embedded quotes™ within
"text fields" which have surrounding begin-quotes and end-quotes. For example [,""] is a case
of an embedded double-quote, but [,",] is not.

Body of text exceeds maximum of 20,000 characters (F99 filings)
e F99 (Miscellaneous text document) filings are limited to 20,000 characters in length.
e To correct this, either shorten your Form 99 filing or file more than one.

Leading blanks {e.g. ** TEXT""} not allowed
e This indicates that there are blanks prior to data; this is not allowed.
e Locate the transaction/field and delete the spaces that precede the first word in the file.

Bad date — not YYYYMMDD format
e This indicates the user has entered a date in the incorrect format.
e Locate the transaction and re-enter the date trying this format: MM/DD/YYYY.

is not a real date
e This indicates that the user has entered an invalid date.

e Locate the transaction and enter a valid date.

Invalid amount format: — OR — Non-numeric data in numeric field
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e This indicates that the user has entered values other than m x|
numbers and decimals.

e Locate the transaction and enter only numbers and one decimal N e e e
point. FECFile will issue a warning before this error is made.

(See right)

e NOTE: Dollar signs and commas are not permitted.

is an invalid year (CCYY) format
e This indicates the user has entered the year in the incorrect format.

e Locate the transaction and make sure the year referenced in the date field is in a four-digit
format.

District "__"" is not 2-digit numeric format
e This indicates the user failed to enter the congressional district as two digits.

e Locate the transaction, and make sure the congressional district field has two digits (ex: 04, 11).
Using the FEC Lookup feature might make things easier.
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